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Exercises connected to training project Course B1

Introduction

These exercises requires that the specific training project Course B1 is available as a demo project. It can be distributed in the basic training
course for oil and gas or it can be downloaded from Course B1 . Be aware that the downloaded training course is a zip file and you have to
unzip it.

The basic training course will use these exercises as a reference to get a good start working with Geocap in the oil and gas industry. The
exercises are also suitable for self training and studying features of the Geocap software.

The primary data in the training project like seismic sections, seismic interpretations, well data, georeferenced image and etopo2 coastline
and grid are loaded into the project as described in Importing Data in the user guide and the training tutorial Cultural and Bathymetric Data.

The main goal with these training exercises is then to show the correct use of data; how to visualize data and check quality; how to make the
best use of Geocap algorithms and to present presentation graphics on screen and in plotting.

In this section:

® Introduction

® The project Course B1

® How to work with the project.

® Contents of the downloaded file.

The project Course B1

Course Bl is a basic primary training project for oil and gas projects. The data sets are pseudo realistic; i.e. they are from real cases, but
transformed to a new place. The size and amount of data are trimmed down in order to make it downloadable. Yet they represent a typical oil
and gas case that is suited to demonstrate what Geocap can do with them and how it is done.

For convenience the folders have a prefixed number so they will keep that ordering. A Geocap project has a free structure and the user can
have it organized in different ways. A good rule is two have a limited number of top folders and go into the depth when necessary.

How to work with the project.

The training is organized by a set of exercises using input data from the project or creating data from scratch in some cases. The user is free
to work and extend Course B1 as the only project or creating a new project that gradually becomes more and more similar to the master
project. The latter choice require that one can handle two projects simultaneously and has the advantage that the master project remains
undisturbed and the exercises refer correct to it.

But the first choice to use the Course B1 project directly is probably most convenient in a direct exercise situation. Just create parallel folders
and data sets whenever needed.
r. Compatible Geocap release for current Course B1

® Both Geocap and Course B1 are trimmed and upgraded frequently.
® The current version of the downloadable Course B1 requires the release Geocap 6.0.11 or later.
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Contents of the downloaded file.

ﬁ The folder Course B1 contains these folders

® db contains the project Course B1. Browse in the project by clicking on this folder.

® plot contains a Postscript file and a pdf file showing a Geocap plot. Also the saveset for the plot and a logo.
* workflows contains the workflow Seismic and reservoir models - course B1.gwf that have 11 workflows

showing project scenes.

Place the folder structure on your own computer where it suits you. All the workflows are only dependent of the project and will run fine when
the project is loaded. The logo is referred to in the saveset of the plot and must be browsed over again in order to run the plot.

01 Generate project window

Project window

The project window is an important concept. It defines the area of interest (AOI) of the project. Usually it is equivalent to the grid window;

i.e. the area of the grid models of the reservoir.

Exercise

Generate project window
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. Zoom to data on the interpretation lines in the project: _02_Time data > Interpretation lines
. Display the seismic interpretation lines.

. Draw the windows frame by clicking D

. Set the screen in 2D mode.

. Display the border line from the project: _01Cultural > Boundary > border_line

. Use Tools -> Quick Digitizer to digitize your own border line and save it. F.inst. name it border_line2.

o 0w N

1. The project window is usually set in the Project Settings panel under Data
® Click on the tool icon on the project bar.

a. Look at the other options in the project settings panel.
Section - Used to change project name.
Data - Project window that will be activated when loading the project.
Geodetics - We use UTM 51 S as our projection and WGS83 as our datum.
Graphics - It is an advantage to erase the screen when loading the project because the no graphics from
another area will disturb the current graphics when the system calculates visualization parameters.

" Features regarding the project window
All the reservoir grids in the project are usually gridded within the project window.
® The gridding panels have there own window settings that should for convenience
coincide with the project window.
® |f you change the project window and use that as a new grid window you cannot
mix grids with different grid window in a reservoir model.

~
T =
Section
General Data Window
Data
Geodetics
Graphics X: -188000 -47500
¥ 7.8645%+08 7.958e+06
Z:z |0 6000
Set data window when loading project
Z axis direction: Down - ]
Il I 3
Apply settings when loading project
OK l ’ Apply ] ’ Cancel
e

Project window set in the Data section in project options

7. The file 01Cultural > Boundary > window_aoi is the window frame as a data set. Whenever you apply Zoom to
Data on this data set the project window will be set again. The *window_aoi is also used in the workflows for display
purposes. Generate the window frame data set.

ﬁ How to generate the project window data window_aoi
Do the shell command dra win sav to display and save the window frame.
® do mlo *win to retrieve the window dataset from its workspace buffer.
® Go to the project and do: _01Cultural > Boundary > New > Workspace Data > active to
get the active data set into the project.
® Rename it to window_aoi?2 to distinguish it from the one already present.

8. Display the window frame dataset and click on the axes icon on the toolbar to see the coordinates.

9. Acivate the compass icon to see the orientation.
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/¥, Notes about setting a graphical window

® The graphical window determines what are that will be displayed.

® When the project is loaded and the *project window__is set it is equal to the graphical window.

® The graphical window can be set interactively by using the *z' key when the screen has focus and is
in 2D mode and you draw a rubber band.

® The shell command win xmin xmax ymin ymax zmin zmax will set set window.

® The project action Zoom to data | Zoom to folder sets the window.

® The project settings panel can update its data window from the current window.

02 Seismic sections and interpretation lines

Seismic sections and interpretation lines.

The seismic 2D sections were used to interpret horizon lines and faults. Interpretation lines can in general be work out in Geocaps
interpretation system. But in this case they were interpreted from an external interpretation system and imported into Geocap. This is often
the case because there are many specialized interpretation systems around.

Exercise

Display and compare seismic sections and interpretation lines.

Display a seismic 2D section. Try LOD display and ordinary display.

Use the x key letter to set a focus and rotation point on the seismic.

Drop color tables on the section. Use the Adjust color table range icon to study color table effects.

Display the seismic navigation lines. Use the icon Locate project object from graphics to identify a seismic section.
Display interpretation lines in various line thickness. Try also point display.

Evaluate the interpretation quality. Are the lines auto tracked or digitized?

oahrownE

Seismic 2D sections and navigation lines
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Detail of seismic and interpretation lines

If you want to correct or reinterpret some parts of the interpreted lines they have to be imported into Geocaps interpretation systems; see
Importing Interpretation and Seismic Interpretation. Not all seismic 2D sections are in the course project, but they are present in the Tutorial
datal which can be downloaded.

03 Gridding

Gridding and surface modeling.

Grid models are essential in modeling reservoirs. Good grid models require good input and well tuned algorithms.

In this exercise we will use as input seismic interpretation lines and closed stick faults. There are seven interpretation sets including the
seabed. The reservoir has six horizons. The bottom five have fault lines as input while the top one don't use any faults.

Geacap


https://geocap.onconfluence.com/display/ug/Importing+Interpretation
https://geocap.onconfluence.com/display/ug/Seismic+Interpretation
ftp://documentation:GeocapUser@ftp.geocap.biz/Tutorial%20data1.zip
ftp://documentation:GeocapUser@ftp.geocap.biz/Tutorial%20data1.zip

Page 6

Exercise

Grid a time surface from seismic interpretation and no faults.

. Display interpretation lines from 02_Time data > Interpretation lines > 02BasePliocene.
. Apply the command Simple points and lines gridding

. Click Update window to get the project window as the grid window.

. Set x and y increment to 500.

A WN P

) Grid window for Course B1
® xmin = -188000, xmax = -47500; ymin = 7864500, ymax = 7959000
® Using grid increment 500 gives as size of grid: number in rows: 282 , number in columns:
190
® |tis arelatively small grid, but useful in a course and the size of the project is kept
reasonable low.

5. Check in Apply reference grid or outline and browse in: 01_Cultural > Boundary border_line
6. Use gridding algorithm Parabolic (default).
7. Check in for Use two steps gridding. Grid increment will be automatic calculated if blank.
8. Set moving average as gridding algorithm for 1. step.
9. Click Execute. The result will be written to the same folder.
10. Click OK and save the panel with all parameters.
11. Create a new folder for interpretation grids and cut/paste the result grid into this folder.
12. Display the result as shown below.

) Displaying color legend
® The color legend is often displayed with the shell command cco. In the example below the
following procedure was used:
® Screen in 2D mode. Click a cursor point at lower right.
® Use the shell command: cco rev cur col bla tit Time. The cur argument refers to the
cursor position. Look at the reference manual if necessary.

Base Pliocene

T
7 //H\ 940000
71/ 11\
;¥ ! ] 20000
7 7 1] T | /f
/f// l‘ \ ..;/ f{'! 200000
/ X / 880000

~180000-150000-120000-90000 -60000

Base Plioscene interpretation lines and border line
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Base Pliocene Time

Base Plioscene grid

/1 Grid menus using faults

® The grid menu when faults are included is Gridding points, lines and faults. This menu can also be used when
there is no faults, but the one we used is a simpler alternative.

Exercise

Grid a time surface from seismic interpretation and closed stick faults.

1. Display 02_Time data > Faults > 07SilurianFaultint_Polygons. This is how the fault polygons comes from Kingdom
. They must be edited.

2. Use Edit points and lines to remove the blobs. See Gridding seismic interpretation with faults.

3. The correct edited fault lines are in 02_Time data > Faults > CorrectedClosedFaults. Use this if you don't have time
to complete the editing.

@ Tips when editing fault lines with blobs
® To remove the blobs just delete the two extra points in the blobs.

. Apply the command Gridding > Gridding points, lines and faults and activate it on the proper interpretation lines.

. Don't alter type of input data (under development). Use default: Single points.

. Click Use active window to get the project window into the grid window.

. Set the x and y increment to 500. Click Adjust to Increment to secure that the grid window is adjusted to the
increments. If the grid window changes update the project window in Project Settings. It is an recommended that the
project window and grid window are equal and adjusted to the grid increments.

8. Click Calculate to get number of elements in rows and columns: 282 x 190.
9. Go to the Fault Input tab.

10. Check in Closed stick faults and browse in: 02_Time data > Faults > CorrectedClosedFaults

11. Clik Test at bottom to do the blanking test. The fault polygon should be filled inside. No lines outside.

12. Go to the Grid options tab.

13. Check in Use reference grid or outline and browse in: 01_Cultural > Boundary border_line.

14. Check in Use two gridding steps.

15. Go to to Result Grid tab.

16. Set the saving option to Save in project. The result grid will be saved in the same folder as input unless another folder

is browsed in.

17. Click Execute

18. A default display of the result grid appears. Delete this and display using Display Contours.

19. The faults lines have been assigned z values and are located in workspace as closedGenFaults. Transfer them to the

project using: folder > New > Workspace Data > closeGenFaults.

20. Click OK to save the grid panel.

21. If time, repeat the procedure for all faulted horizons. If not use the data in the course project.

~N o oA
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Silurian interpretation lines and faults

Silurian grid with faults and input lines

04 Layer models and cross sections

Layer models and cross section.

A layer model is a collection into a layer folder of grids which have the same grid position and resolution. The layer folder is of type Generic
and has the Schema Layer model.

Exercise

Create a layer model.

1. Create a generic folder and set the schema to Layer Model.

2. Copy all time grids into this folder and secure the correct ordering from top to bottom by placing a prefix number 01 02
03 ... etc.

. Perform Zoom to Folder on the time layer model and draw the window frame and axes.
. Display all the layers in random colors.

. Create a map command that display the color using color range from 1000 to 4200.

g~ w

A layer model consisting of interpretation grids may have grids that go deeper that the next grid in sequence. We then have to check the
layer model and if necessary do truncation.
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Exercise

Check and truncate the layer model.

1. Visualize the layers one by one to see if there is any overlap.
2. Activate upon the layer model the command Check and truncate layers from top and downwards.
3. We run on defaults; therefore click on Execute to perform truncation from top and downwards.

Layers mapped with the same color range

Having a layer model it is convenient to make cross sections.

Exercise

Create cross sections.

1. Highlight layer model folder and read the command Information about the layer model.
2. Activate the command Initialize the layer model into Workspace. The layer model grids are read into workspace for
fast retrieval.

o Layer model grids
® When the layer model grids are in workspace it is quick to perform cross sections and other
calculation.
® |f a another layer model shall be studied just activate Initialize the layer model into
Workspace on the new layer model.
® Cross sections will be performed on the layer models grids in workspace.

3. Create a new Generic folder and give it the name Cross sections and set the schema to Cross sections. Cross
section commands will now be visible on this folder.

4. Do on the cross section folder Display fence type cross section. It will display and the fence data is saved in the
cross section folder.

5. Erase the screen and open the cross section folder perform on the fence data Vertical redisplay from cross section
data.

6. Activate on the cross section folder Legend for cross section.

7. Try the other cross section commands.

@ Setting cursor for cross section action
® When doing cross sections it is smart to have the bottom layer displayed.
® Place a cursor position on the bottom layer using key letter y when in 3D mode, or just click
when in 2D mode.
® Cross section between two cursor points: Set two cursor marks. Geocap remember them
even if only the latest is shown.

Geacap
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Cross section study of the time layer model

Another option for fast cross sections is to generate a solid layer cube.

Exercise

Create a layer cube.

. Use Zoom to Folder on the layer model to get the overall layer window.

. Highlight layer model folder and activate the command Cube generation of all layers.

. Click Use Active Window to set the cube window.

Set the cube grid increments to 500 500 20 to get 282 x 190 x 20 grid nodes.

. Click Execute. The cube is saved in workspace cubegrid.

. Get the cube gid into the project under the Time folder and rename the cube to time_cubegrid.
. Apply the Manipulator to display the layers in the cube in a fast way in all directions.

NoOo A wWNPE

(% Setting cursor for cross section action
® The manipulator is for a cube is activated by cube > Utilities > Manipulator cube display.

8. Run the manipulator in all directions on the cube.
9. Display a layer grid to verify that the cross sections from the cube have correct extensions.

Cross sections displayed from a layer cube

05 Stacking velocities

Stacking velocities.

The stacking velocities are collected along the seismic lines and processed to show time versus velocity of the seismic reflectors. The data
is used to generate a time velocity cube.

Geacap
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Before using then uncritical it is common to display and check the gquality and extent to see how deep the cube should go.

The stacking velocities are located as in 06_Velocities as Survey03 and Survey04. There are more surveys in the dataset Tutorial datal ,
but in this project we only need 3 and 4.

Exercise

Display stacking velocity.

Do Zoom to Folder on Survey03.

Open up folder Survey03; click on a stacking velocity dataset.

Perform Map Data. Zoom in and study the display. The lines are mapped.

Erase and perform Make bands of velocity an map. Zoom in and study the display. It is solid.
Try different display commands on the various velocity data sets.

Go to the Command panel. Use Display survey lines. Transfer this command to the Toolbar.
Highlight folder Survey03 and apply Display survey lines from the Toolbar.

NoouhkwbdpE

Stacking velocities collected and mapped

Gridding stacking velocities requires that all lines are collected into one file.
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Exercise

1.

~N~NouabhwN

Appending stacking velocity into one file.

Highlight folder Survey03 and apply Append all lines in a folder from the Command section under Schema
Commands.

. The result is appendedData in workspace. Create an temporary folder and put it there. Rename it to appendedDatal.
. Perform Append all lines in a folder on Survey04.

. Put appendedData into the temporary folder.

. Perform Append all lines in a folder on the temporary folder. The final result is now appendedData in workspace.

. Transfer appendedData in workspace to the project under 06_Velocities and rename it all_lines.

. Delete the temporary folder.

»ﬂ Note on appending data

® We did not use Append all lines in a folder on the 06_Velocity folder because there are data in it
that should not be appended.

® Appending could have been done quicker with the shell command mhi/mlo data app. The menu
uses these commands.

® We could have avoided the temporary folder if we appended once; then edited the Append all lines
in a folder on the next survey and clicked on Prestep and removed the command dhi
appendedData which means delete workspace data appendedData. Then we can continue to
append without deleting in the prestep. The final result is appendedData which we can transfer to the
project.

06 Velocity cubes

Velocity cubes.

Velocity cubes are generated from stacking velocities and check shot wells. The dimension of the cube is in the time domain, while the
contents: i.e the cube nodes are velocity values. The cube is thus also called a time velocity cube. The purpose of the velocity cube is to

have a fast and reliable method for depth conversion.

There are several methods of generating the velocity cube:

1 Methods for cube generation

1. An overall gridding method that transfers the stacking velocities into the cube by one master command. This
method is used in Geocaps cube gridding panel.

2. Gridding individual cube layers and insert them into the receiving cube. This method can be used by users that will

script up sophisticated logic for detailed control and quality.

The stacking velocities were collected into one dataset called all_lines in the 06_Velocity folder.

Exercise

abhwnNBE

Digitize a border line for the cube.

.ﬂ Border line for the cube

® We need a border line for the interior of the cube. This line should go a little outside
_border_line_used for the grids.

® The cube size should extent the time grids a little bit in order to get no edge effects when depth
converting.

. Put the screen in 2D mode.

. Digitize a closed line just outside border_line.

. Transfer it to the Boundary folder and name it cube_border.

. Set the screen back into 3D mode.

. Perform Zoom to Data on window_aoi (or use one of the grids) to secure the grid window is back.
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Exercise

Grid stacking velocity into a cube.

1. Highlight the stacking velocities all_lines in the Velocity folder. Activate Cube gridding from stacking velocities.
2. Select correct attribute by clicking Set. The combobox should shift to Scalar. Sometimes the velocity is the field data
velocity, but in this case it is in the scalar part.
3. Click Use Active Window to set the cube window.
4. Set zmin to 0 and zmax to 6000 which will be the size of the cube in the z direction.
5. Set the cube increments to 500 500 50 which is an acceptable resolution in our case.
6. Click Expand to expand the cube window a little bit to avoid edge effects when depth converting.
7. In our case the size of cube is now 286 194 121.
8. Go to the Grid Options tab.
9. Click Use reference grid or outline and browse in cube_border.
10. Go to the Cube Options tab.
11. Click Apply base grid and browse in 01Seabed_time from the _06_Velocity folder.

/1 Note on the base grid 01Seabed_time

® A base grid tells where the values from the stacking velocities start. Above the base grid it is
only water and the values are the water velocity.

® The seabed in time is the natural base grid and 01Seabed_time was gridded from time
interpretation lines.

® The grid window and x y grid increments for 01Seabed_time must be exactly equal to the
cube.

® You can do that gridding as an exercise later on. For the moment use the one in the course
project.

12. Go to the Result Cube tab. Observe that the result cube by default is written back to the same folder as the input.
13. Go to the Testing tab.

14. Drag the slider bar and set the z value to around 2500.

15. Click Make velocity grid to perform a test for that level.

16. If everything is OK click Execute to generate the velocity cube. It will be saved as all_lines time_velocity.

Testing the cube gridding
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Velocity cube displayed in transparent mode wit one time layer inside

) Checkshot data
The velocity cube will usually be checked against check shot wells; i.e. wells that have correct time and depth values
downwards.
This project does not have appropriate check shot wells for the area at the moment so here is only the technical procedure.

® Use the command Deviation velocity cube and wells to see the difference between the cube layers and the
crossing with the wells.

Exercise

Using check shot data to adjust the velocity cube.

1. Highlight all_lines time_velocity and activate Utilities > Adjust velocity cube to checkshots.
2. Browse in the check shot data.

3. Specify the correct format of check shot data.

4. Click Execute to perform the adjustment.

Exercise

Displaying the velocity cube with the manipulator.

There are many ways to display velocity cube data. They are all visible on cubes. Try them out and be familiar with them. The
primary one to learn is to use the manipulator.

1. Highlight all_lines time_velocity and activate Utilities > Manipulator cube display.
2. Draw the manipulator in all directions by checking X Y or Z.

Using the manipulator to see cube planes

Geacap
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Exercise

Displaying different iso contours from the cube.
Iso contours is a direct way to see the interior of the cube. If too noisy one should consider smoothing the cube.

1. Highlight all_lines time_velocity and activate Cube contours.

2. Draw the contours for the values 2000 3000 3800

3. Evaluate if it is noisy. In that case smooth the cube.

4. Activate Smoothing Cube and perform smoothing and redisplay the iso contours.

Checking the cube by displaying cube contours

07 Depth conversion

Depth conversion.

Depth conversion will transfer the time grids to depth grids. In that process we use the velocity cube in the algorithm.

The time grids are probed into the velocity cube and the transition to depth grids occurs by sampling velocity values from the cube onto the
tme grids.

The standard conversion formula is then used: depth = time x velocity.

Exercise

Transfer time grids into depth grids.

. Copy the time grid folder and paste it into the Depth data folder.

. Activate on the pasted grid folder Utilities > Depth conversion of time grids in folder using velocity cube.
Read the info and browse in the velocity cube.

. Click Execute to perform the depth conversion.

AWM P

Exercise

Display depth grids.

1. Display the same time grid and depth grid to see how it is shifted.
2. Activate Initialize layer model into Workspace on the depth grid folder.
3. Make a new cross section folder and perform cross sections in all directions.

Geacap
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se Jurassic

Base Jurassic is deeper when transferred to depth

Cut

Cross section through layer model of depth grids

08 Reservoir and volume calculations

Reservoir models

In order to calculate HCPV (i.e. hydrocarbon pore volume) for the reservoir there has to be a reservoir model. This is a folder with reservoir
horizons in layer model and folders with petrophysical parameter grids.

The parameter grids are connected to the zone between two horizons and the zones in the layer model start with the first horizon. There are

seven horizons and six zones; therefore the last horizon will have no petrophysical parameter grids associated.

1 Petrophysical parameter grids

The petrophysical parameter grids in the volumetric model are random generated between 0.1 and 0.6 approximately. That
corresponds to realistic value domains. In real cases the petrophysical parameter grids are gridded from well data, f.inst.
using the gridding panel Simple points and lines gridding.

The parameter grids should be organized as shown in the folder 09_Petrophysical parameters.

Geacap
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Layer model and cross sections
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Folders showing the layer model and petrophysical folder with parameter grids
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Exercise

Calculate hydrocarbon pore volume within a license.

Right click on Depth data > Grids interpretation and activate Volume layer model calculation.
Set Type of volume to be calculated to Between planel and plane2.

> @ N

Check in 2: contact and write in the level value 3800 (suitable for this project). Also called bottom

® |f there is only one contact plane you just check in 1: contact.
® There are two types of calculation:

a. From top reservoir to Top contact.

b. Between Top contact and Bottom contact.

5. Check in Apply folder or single area grid or outline for licenses or sub areas.
6. Browse in 01_Cultural Licenses > License 07-18.
7. Go to page Parameters.
8. Check in boxes for petrophysical parameters and browse in the corresponding folders.
9. Check in Expansion oil and set the value to 1.2.
10. Check in Recovery factor oil and set the value to 0.4.
11. Click Execute to start calculation.
12. Go to Result page.
13. Click on Volume report.

parameters set and a time stamp.

® The folder has a typical name: Volumetric reports_Grids Interpretation_Wed Nov 16

2011.
® The report has a typical name: VR_Grids Interpretation_2700_3800_Licens

14. Take the volume report into a editor and read it.

Check in 1: contact and write in the level value 2700 (suitable for this project). Also called top contact.

® Goes default to your home area on disk and is placed in folder. The names are made of

contact.

Volumetric report

Proj ect: Course Bl
Vol unmetric report for horizons in folder: Gids Interpretation.
Cal cul ated and saved at: Wed Nov 16 08_55 46 2011

Par anet ers present and used:

Type of volume to be cal cul ated: Between planel and pl ane2
First horizon used: 02BasePliocene

Last horizon used: 07Silurian

Contact plane 1: 2700
Contact plane 2: 3800

Li cense or sub area: License 07-18
Porosity folder: Porosity
Net to Gross folder: Net to Gross

Water saturation folder: Water Saturation

Expansion value oil: 1.2
Recovery factor oil: 0.4

Units used in report table: Cubic km (1079)

Zone Bul k Por e HCPV I nPl ace Recover abl e
02BasePl i ocene 57. 859400 33. 751980 10. 205310 12. 246370 4. 898550
03Upper Cr et aceous 446. 479170 174. 687160 41. 260900 49. 513080 19. 805230
O4Lower Cr et acUCo 794. 343640 384. 093490 79. 636180 95. 563410 38. 225360
05BaseJur assi ¢ 4603. 565830 1667. 313830 563. 336510 676. 003810 270. 401530
06BaseTri assi ¢ 1299. 398520 542. 952390 85. 428700 102. 514440 41. 005780
Tot al 7201. 646570 2802. 798850 779.867600 935. 841120 374. 336450

As one can see the names are generated by a simple system created by parameters used and a time stamp. For the folder name, the time
stamp follows the day, while for the report itself, the time stamp is the actual day time down to seconds so the name will be unique. The
b_p_n_w stands for _bulk porosity nettogross watersaturation to show that these parameters were present in the calculation.

Ge@cap



Page 20

Display features

Exercise

Display recoverable hydrocarbon volume within a license.

Click on Display to display volumetric results.
Select zone 4.

Set option to As single volume.

Click Display volume or contact area.
Study the display and explain the map.

agrwbdPE

Exercise

Display hydrocarbon volume and cross sections.

Click on Display to display volumetric results.
Select zone 3.

Set option to On bottom of horizon.

Click Display volume or contact area.

Make a cursor position with the y key.

Click Get cursor values.

Click X direction.

Click Perform cross section from position values.
Study the display and explain the map.

©CONoGOLWNE

Base Jurassic recoverable volume as single volume grid

Base Jurassic draped on Base Triassic and cross sections
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Exercise

Display hydrocarbon volume and fence diagram.

Click on Display to display volumetric results.
Select zone 4.

Set option to On top of horizon.

Click Display volume or contact area.

Click Fence diagram cross sections.

Study the display to and explain the map.

@S> @NE

Exercise

Display recoverable hydrocarbon volume within a license.

Click on Display to display volumetric results.

Select zone 4.

Set option to On top of horizon.

Check in Display contact area (on zone top only).
Click Display volume or contact area.

Check off Erase screen.

Select zone 5.

Click Display volume or contact area.

Go to the Volume page and display the contact planes.
Study the display to and explain the map.

COXNOGOLEWNE

[N

= i
Volume draped on Base Jurassic and fence diagram

Base Triassic and Silurian and contact planes

Advanced display of volumetric results
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Here is a viewport presentation of all volume grids draped on the top horizon for the zones. Try to reproduce it by following the steps.

Exercise

Display the volume grids for all zones in the layer model.

. Click on the viewport icon on the toolbar and open the viewport menu.

. Check in Connect all viewports.

. Create 2 x 3 viewports. You now have 6 connected viewports.

Click on viewport at upper left to get that viewport frame in red.

Set all parameters correct in the volume menu and Execute it.

. Go to the Display page.

. Select zone 1. Select On top of horizon. (All selections will do, and one must be consequent).

. Click Display volume or contact area.

. Go to the shell and type the text: tx2 .7 lle col bla txt "Base Pliocene". (2D text at lower left; see the ref. manual).
10. Click on the next viewport.

11. Select zone 2 and repeat the previous steps for zone 2.

12. Repeat the steps for zone 3, 4 and 5.

13. Put the viewports in 2D mode to see it from above.

14. To display the lower right viewport (it is number 2) in 3D mode do as follows:

15. Go to the command shell and type: vie 2 con off.

16. Check in Display contact area (on zone top horizon only).

17. Select zone 5.

18. Click Display volume or contact area.

19. Make a proper size of the screen and apply generic folder >New > Screenshot to save the picture.

©COENOUAWN PR

Viewport display of volume maps draped on the top horizon for each zone.

Base Jurassic

Base Triassic Base Triassic contact zones
Volume display for all zones in the training project Course B1

The procedure for making the viewport display is described as many interactive steps. It is however possible to set up a workflow to do it all
in one action.

The documentation for volumetric calculation is located at Volumetric Calculations. Near the end of the chapter is a larger version of the
viewport display.

Ge@cap


https://geocap.onconfluence.com/display/ug/Volumetric+Calculations

Page 23

09 Volume calculation for grids

Volume calculation for one or two grids.

Volume calculation for one grid and an isopach or between two grids and optionally two contact planes does not require a layer model and
can be done quite easy with a dedicated menu called Volume calculation that is directly visible on a grid. The volume calculation operates
with singles values for the petrophysical parameters and singles values or grids for contact planes.

Below is a sample task to illustrate volume calculation.

Exercise

Calculate HCPV volume for a zone.

We want to calculate HCPV volume between Upper Cretaceous and Base Jurassic in the layer folder for
depth grids.
The volume will also be between the contact planes 2500 and 2900 and within the license area.

[

. Highlight {04_Depth data} {Grids Interpretation} 03Upper Cretaceous and activate Grid Operations > Volume
calculation.

. Check in Apply a bottom grid in calculations.

. Browse in {04_Depth data} {Grids Interpretation} 05BaseJurassic as the bottom horizon.

. Set Type of volume to be calculated to Between planel and plane2.

Check in Specify plane 1 level and set the value to 2500.

Check in Specify plane 2 level and set the value to 2800.

. Check in Use area grid or outline and browse in 01_Cultural Licenses {Licens 07-18}

. Write in values for porosity = 0.4, water saturation = 0.5 and net to gross = 0.6.

. Click Execute to perform HCPV volume calculation.
The result is: Volume calculated from 2500 to 2800: 133.72658 cubic km (E9)

©CONO U~ WN

The display options are placed under the Display tab. Open that tab.

Exercise

Display volume grids.

1. Click on Display calculated volume when the combo box is As single volume.
The result is the lower left display.
2. Click on Display calculated volume when the combo box is On bottom of grid.
3. Set a cursor marker with y and click Get cursor values.
4. Click Perform cross section from position value.
The result display is shown below to the right.

‘j:ig;l

5P
Volume: 133.72658 cubic km (E9)

Volume grid displayed as single volume
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Volume grid and cross section displayed on bottom grid; see comments

1, Comments on Volume grid displayed on bottom grid

The picture shows the volume grid draped onto Base Jurassic. The grid is not present outside the area of positive volumes.
In addition a cross section is displayed and shows clearly where there are no volume because the top grid is below the
bottom contact plane. The cross section study illustrates that clearly.

Exercise

Display top and bottom grids and contact planes.

Display the top and bottom grid from the project.

Display the two contact planes.

Mark with y a cursor position at the top plane and type the shell command: tx2 col red cur fol txt "GOC 2500"

. Mark with y a cursor position at the bottom plane and type the shell command: tx2 col gre cur fol txt "OWC 2800"

P ONE

Top and bottom grids and contact planes

Exercise

Create a cube with top and bottom grids and contact planes.

1. Click Create cross section cube.
2. Click Activate frame and move the manipulator to see the cross section planes in red green and blue colors.
3. Display the bottom horizon.

Geacap
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Cross section cube for gas, oil and water

Exercise

Calculate curve for area versus depth.

. Use exactly the same settings as in Exercise Calculate HCPV volume for a zone.

. Check in Calculate area or volume against depth.

. To calculate area / depth the combo setting is Calculation is done using: area.

. Push Execute

. The area / depth curve is saved in the project as {Course B1}/ 01_Cultural Curves_area_depth

03UpperCretaceous_area_depth_curve.

. Display the area / depth curve by pushing Show curve. The screen is blanked and the area / depth curve is

displayed. Instead of using the existing screen window a new window or a new Tab could have been established.

7. Write the text Area / depth from 2500 to 2800 at top of the window. This is done most easily by clicking a cursor point
(in 2D mode) at top left. Then go to the command shell and write: tx2 cur col bla txt "Area / depth from 2500 to
2800"

8. The area/ depth factor is set low to have the area numbers small. The real area numbers are multiplied by the factor.

O ONBE

(o]

Area / depth from 2500 to 2800
-2520

-2560

-2600

-2640

-2680

-2720

-2760

0 1000 2000 3000 4000 5000 EDD&EBDD
aread / depth , factor: 0.000001

Area versus depth between 2500 and 2800
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10 Plotting

Plotting

.ﬂ Geocap can produce Postscripts plot of very high quality. That is: If the user puts some effort into the details and run some
test plots until the required plot quality is achieved.

However, it is easy to get a nice plot and afterwards one can produce lots of plot with the same setting and quality,

Another advantage with Geocaps plotting system is that the output is very small. It has been filtered down to absolute
minimum and is very suitable for plotters of all kind as well as converting to PDF files.

The downloaded file Course B1 contains a folder called plot which contains a Postscript file and a PDF file of a Geocap plot. Display the

PDF file.

The folder contains also the saveset for the plot and a logo. The location of the logo in the saveset must be changed; see below.

Exercise

Start the plotting system and read the saveset for Course B1.

. Activate Tools > PostScrip Plotting. The plotting menu appears.
. Do File > Read saveset and browse in BaseTriassicl.saveset in the plot folder.

. NB! The disk location of the logo is in 14. Pictures. Click twice on the checkbox and browse in the new

. Click Generate Plot and wait until completion.

. Go to the plot folder and you will find BaseTriassic2. It is a Postscript file.

. Display BaseTriassic2 using GsView or any system that can read and display Postscript. It should look like the

. Transfer BaseTriassic2 Postscript file to PDF. There are many freeware systems on internet that can do that: try

. Use the Help entry on the toolbar for more information about the plotting system and how to use it.
. Optional: Replace the Geocap logo with your own logo.

H Notice that the plot name is BaseTriassic2 so the original BaseTriassicl will be kept.

]

location.

display below.

f.inst. PDFill PDF Tools. The PDF file was generated with that system. Also the image below which was converted
from the PDF file.
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Base Triassic time map

Geecap
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Postscript plot of Base Triassic and survey lines and license area (70 % reduced size)

11 Wo

rkflows

Workflows

The Course B1 project has an associated workflow called Seismic and reservoir models - course B1. It is located in the workflow folder
of the downloaded file.

The workflow is a set of commands that are chained together to show data from the project and is very suited in presentations of all kinds. It
relieves the user from remembering where the data are located and also in which sequence they shall be presented.

A workflow is created in a tree structure much like a project. The actual workflow here has many topics that are separate workflows. They

have prefix numbers to have a natural ordering.

The Flight Tour command makes the workflow shift from one scene to another in a smooth way much like flying. They are used frequently to
get a proper start scene and to fly to new camera positions to see other details.

A workflow is unprecedented in a presentation and is impressive when elaborated.
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’( Workflow:Seismic and reservoir models - course B1
|
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= Initialize workflow
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I3 Seismic text
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&’ Base Triassic interpretation

& Base Triassic faults

Be Contour Base Triassic

@ Fiight Tour

I3 Prospect X

I 03 Stacking velocity and velocity cube
I 04 Reservoir model

I3 05 Bulk volume model

I 06 Volume calculation

I3 07 Triassic bulk volume calculation
L 08 Well log display

L 09 Vertical calibrated image 1
£ 10 LOD Seismic display |
[ 11 Cartographic display
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-
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= 1|
The workflow created to show data from project Course B1

Exercise

Read the workflow file and execute the workflow.

Click File > Open > Work Flow.

Browse in Seismic and reservoir models - course B1 from the worflow folder.
Make sure that the project Course B1 is loaded.

Maximize the Geocap screen.

Run the different workflows by right click and Execute.

Try also the Execute button on the toolbar of the workflow.

ouprwONE

@ Study the workflows and see how they are created

® Do Edit on the various workflow elements.

® Create your own workflow, f.inst. just displaying a grid and some associated data.
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; 3
A scene from the workflow

12 Presentation graphics

Presentation graphics

Nice plots are always a wish to achieve. Good plots can be done by our plotting system. But sometimes a screen image must do.

Below is a cartographic plot that is produced by the workflow 11 Cartographic display in Seismic and reservoir models - course B1

Exercise

Study the workflow 11 Cartographic display.

. Run the workflow.

. Open the workflow folder and see which elements are present.

. Do any image folder > New > Screenshot to save the image.

. Change some parameters to see the effect.

. Add some text by introducing a new text command to get familiar with the method.

abrwWNBE

& Notes on presentation graphics

® To achieve high cartographic standard it is an advantage to know Geocap and all details well.
® Personal preference is important so presentation graphics is a relative issue.
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Cartographic display Base Triassic

116°30'E 117°0'E

117°30'E

D%pﬁj
300
5 1750
2000
2450
2300
2350

0009

19°0'S

3430
3300
3730

UTM zone 51 S

Presentation of Base Triassic with cartographic standard
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